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Application note: Programming C++ on the IPC@QCHIP®

Introduction

This application note discusses the points which should be
considered by the programmer before developing C++
applications for the IPC@CHIP®. There are no restrictions
concerning the C++ programming language on the
IPC@CHIP®. Although there are some points which should
be noted for programming smart and memory saving software.
Furthermore there are some hints how to get access to the
operating system and the hardware of the IPC@CHIP® since
this could be more difficult when using C++. The following

descriptions apply to both IPC@CHIP® development

environments (Paradigm C++ and Borland C++).

All chapters are marked with a symbol above the chapter title.
The symbol describes the type hint(s) in the chapter. The table
below lists type of hints with their corresponding symbol and

meaning.

Marks a chapter which contains hints describing how to
create memory saving programs

Marks a chapter which contains hints on technical or
functional themes.

Marks a chapter which contains hints concerning the theme
“real-time”

® Memory
Functionality
® Realtime

® Tip Marks a chapter which contains general programming tips

Have also a look to the C++ example programs available on

our website (http://www.beck-ipc.com/ipc).
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How to create a C++ project

Create a project as described in the IPC@CHIP®
Getting Started document which is available on our

website.

The files which contains C++ code must be named

*.cpp (e.g. myapp.cpp). So give your C++ files the Figure 1

extension CPP and add them to the project. Figure 1

shows an example project window.

Class methods as callback

Problem: . —
Some @CHIP-RTOS functionalities E? C:project,myapp.c
expect a function pointer, for example
P P P class C [ ;I
the task-functions-pointer, CGil- int myMethod(int i) { J
function-pointer, several callback : Lt B
function like socket-callback a.s.o. }
Sadly the C++ standard does not C oo

support pointers to class methods
int wyFunction(int i) |

(except static class methods; they will return 2+i:

be handled like functions). }

int maini)l {
vold *fp:

Example: vold *mp:

In figure 2 the main function assigns
fp = wyFunction; /7 ok

the pointer of the function named rop——ewylethods S/ not allowed (111

myFunction to the variable fp. The } -

next statement of main tries to assign Kl - 4
Figure 2

the pointer of the method named
myMethod to the variable mp. This is not allowed so the

compiler will give an error.

AN_CPP_V2.PDF Beck IPC GmbH E-Mail: info@beck-ipc.com
© Beck IPC GmbH Grininger Weg 24 www.beck-ipc.com
35415 Pohlheim/Germany A member of the Festo group



Conclusion:
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A solution to this problem is creating a wrapper function. The

pointer to the wrapper function will be given to the @CHIP-

RTOS.

called.

Example:

Figure 3 shows a simple
example program with the

implementation of the wrapper
function named
theWrapperFuntion. In main the
pointer of the wrapper function
will be given to the @CHIP-
RTOS (e.g. as task function,
CGI function, socket callback,
etc.) When
function is called, it calls the

myMethod of the

the wrapper

method

instance c of the class C.

In the wrapper function the class method will be

E" C:hproject,myapp.c

class C |
int wyMethodiint i) [
return 2%i;

H
Coo;
int theWrapperFunction(int i) {

return c.myMethod (i) :

H

int maini) {

PN

|

RBtosRegisterCallback(theWrapperFunction) ;

Figure 3

To be more flexible you could create a global list, in which the

wrapper function searches the according object and then calls

its method. For an implementation example to that theme

have a look into the C++ examples available on our website.
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Calling conventions for functions and class
methods

Problem:
The calling conventions define the name, the structure of the

stack frame and the responsibility for the cleaning up the
stack. It is helpful to know something about -calling
conventions if you intend to call C++ functions/methods from
assembler or if you deal copiously with callback functions and
function pointers.

The C++ calling conventions are mostly identical with the C
calling conventions. Except for three points, the C++ calling

conventions are identical to the C calling conventions.

Conclusion:
So if you want to use a C++ symbol in assembler you have to

note the points below.

1) The generation of the assembler name:

In C the assembler name will be generated by prefixing a
underscore character to the C name.

Example:

myFunction (int 1i); -> myFunction

In C++ the function name will be generated by integrating the
parameter types into the name.
Example:

myFunction (int i) ; -> @myFunction$qgi

For class methods, the class name will be integrated into the
assembler name as well.
Example:

C :: myMethod(int i); -> @C@myMethodeqi
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2) The calling of non-static class methods:

Non-static class methods expect an instance pointer to their
object instance as an implicit parameter on the stack. The
caller has to put the Segment:Offset pointer as last parameter

pushed onto the stack (segment pushed before offset).

3) Function and Methods with default parameter:
The caller of the function or method with default parameters
has to take care that all parameters are supplied on the stack.

(Also the default parameter(s)!)
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Using a struct or a class as return value of a

function or a class method

In C++ functions and class methods could return complex data

types (that means a structure instance or a class instance).

1) Structure instance

Problem:

A function (or class method) which returns a structure instance

expects a pointer to such an instance as parameter on the

function call. So the caller (the calling code) creates an

instance of the structure on the stack before. Then it calls the

function and assigns a pointer to the created instance as a

parameter. Note that the caller creates for every function call a

single instance on the stack. So if you call n times the
same function the caller creates n instances.

If the return value of the function call will be assigned
to some variable (another structure instance), the
content of the stack instance will be copied into the

variable.

Example:

Figure 4 shows a simple example program. The main
function calls the function f two times. The red marked
variables in main (tmp_sl, tmp_s2) are allocated
implicitly by the compiled code. So every call of f costs
4 bytes stack memory (one instance of S requires 4

bytes).

Conclusion:
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E' C,...\MYAPP.CPP
struct 3 {
int i:
int k:

}:

5 E0 1

H

rold main
3 =:
FI8
FI8

S =
=

£i:
£ir:

trp
trp

struct 3 =;
£ do something
return =;

[

sl;
52!

Figure 4
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Pass structures by reference parameter instead of as return
value. This will save some stack memory, because it
eliminates the stack instance and also it saves the copy

operation.

Example:

Figure 5 shows the modification of the preceding program.
Here the instance of the structure S will not be used as a
return value anymore. The function f gets the instance of

S as reference parameter.

2) Class instance

Problem:
A function which returns a class instance expects also a

pointer to such an instance. But the caller does not create an
instance for every function call. It passes a pointer to the
variable to which will be assigned the return value from the
function. This saves the stack instance and also the copy
operation for the assignment.

Only if there is no assignment there will be created dummy
instances on the stack and the procedure described above

(see Structure instance) will be used.

Conclusion:
A better way is to pass class instances by reference

parameter instead of a as return value. This can save some
stack memory, because it saves the stack instance in the case
that the function will be called without assignment of the return

value.
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E' ...\ MYAPP.CPP

struct 3 {
int i:
int k:

}:

vold £(2 & =) |
Ffodo somrething
return:

vold maing)
3 s:

fis):
fis):

Figure 5
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Local Variables

Problem:
The C standard specifies that local variables have to be

declared at the beginning of a function. In contrast the C++
standard allows local variables to be declared inside the code
where ever you want.

But regardless of the location in the code where the local
variable is declared, the variable is allocated on the stack for
the entire execution time of the function (from the functions
start until its end). That means only the scope of the variable
is bounded - not its durability. Important to note is that the
compiler could not detect the life span of variables in different
sections. So it allocates additional stack memory for each

section’s variables.

Example:
The example function f in figure 6 requires about 600 bytes
stack memory (300 integers). This is because the compiler

allocates both int arrays separately on the stack.

Conclusion
Declare your variables at the beginning of the function. This

way you are sure how much stack memory the function

requires.

Example:
The function f in figure 7 requires about 400 bytes stack
memory (200 integers). Both sections of the if-statement use

the same variable.
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[E” MYAPP.CPP =]

int fibool b} {

1f i) {
int i[1007:
Ffodo something
H
else [
int i[z00];
Ffodo something
1

H
| [
Figure 6
E' MyaPP.CPP o =]
int fibool h) |
int i[Z200];
1f ib) {
Ffode something
H
else [
Ffode something
H
H
4| |

Figure 7
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Non-constant initializers

The C++ standard allows non-constant expressions (such as
functions) for the initialization of local variables as well as the
initialization of global variables. The time when the
initialization will be performed depends on the kind of variable

being initialized (global, local or static-local).

1) Global variables (as well as static class attributes)

Problem:

A global variable will be initialized by the startup code of the

application. So the non-constant

initialization  expression  will be
evaluated before the main function
will be called. That means that all
functions which initialize global
variables will be called before main. It
is important to consider that at this
time all other global variables may
not be initialized! So be careful using
non-constant

global variables in

initializers or its functions.

Example:

Figure 8 shows a program which
generates a DIVIDE BY ZERO
exception without any code in the
main function. This is because at
time of initialization of g1000Ticks the
Variable gOneAdd is not yet

initialized.
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B Chproject myapp.cpp
H#include <time.h:>

extern const long gOnelddd:;
extern const clock © glO00Ticks:

Ff returns the time need for
FOoan integer addition
clock t getIntAddClocks()] |

clock t© tO, tl;

int a=1, b=2, o

O = clocki):

o = a + b;

£l = clocki):

return tl - t0O;

Ff nurber of add instructions

S oper 1000 ticks
const long glOO0Ticks = 1080/ gonelddd;

Ff time for & integer addition

int main() [

!

|

const clock t© gOnelddd = getIntdddclocks():

2

Beck IPC GmbH
Griuninger Weg 24
35415 Pohlheim/Germany

Figure 8

www.beck-ipc.com

E-Mail: info@beck-ipc.com

A member of the Festo group




Conclusion:

BELCK.

Be careful using non-constant initializers. Make sure that all

global variables used by your non-

E’ C:,PROJECTMYAPP.CPP

constant initializer are initialized
before use. This includes all global
variables which are used by functions
by

initializers. The initialization order for

called your non-constant
global variables is the order of the
That

initialization of a

declaration of the variables.
means that the
variable declared at the beginning of a

file will be done first.

Example:

In figure 9 your can see almost the
same program as in figure 8. Only the
declaration order of the two global
variables is changed. So now at the

initialization time of g1000Ticks, the

#include <time.h:

extern const long gCneldd:
extern const clock t glOOOTicks:

ff returns the timke reguired for
Ff one integer addition
clock € getIntiddClocks() {

clock © tO, t©1;
int a=1, b=Z, o
tl = clock():

¢ = a + b;

tl = cloack():

return tl-t0; /5 assume L1=E0

ff time for one inrteger gddition
const clock t gOneldd getIntiddClocks () ;

f£f number of add intructions
S pep 1000 ticks

const long gl000Ticks = 1000/ g0Oneldd:
int maini) {
H

I 2

variable gOneAdd has already been

initialized.
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2) Non-static (normal) local variables

Normal local variables will be initialized at the beginning of
each function call (before any function code is executed). Note
that local variables must not be initialized by the function itself
or functions which call this function. Otherwise an endless

loop results.

Example:

Figure 10 shows an example program. The initialization of
the local variable i is not allowed. A call of function f results in
an endless loop. Note that in that case the compiler does not

generate an error!

3) Static local variables

Static local variables will be initialized only on the first function
call. So the execution time of the first function call will be
longer than the subsequent calls (due to the time required for
evaluation of the non-constant initializer(s)). Also there is
again the potential for creating endless loops as mentioned

above for non-static local variables.
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E' C\...\MYAPP.CPP

int £} {
} inti = £}
i
Figure 10
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Exception handling

The C++ standard supports a comfortable exception handling.
It is available with the try, catch and throw keywords. For
building programs which should use C++ exceptions you have
to assure that exception handling is enabled for your project.

Therefore you have to check two options.

The first option is found in the target expert. The target expert
will be opened when creating a new project. If you have
already created a project you can reopen the target expert
with a right mouse click on the .exe node in the project
window. In the target expert window the option No Exceptions
has to be disabled in order to use the C++ exception handling.

Figure 11 shows the target expert with the necessary disabled

option.
TargetExpert 2|
— Target Typer ———— ~Optionsz
0K
tath Support: v |
Static Library [.lib] " Floating Paint
Catcel
= Emulation x—l
& Mone 2 Help |
Platfarm: %
IFleaI address mode j ED EHCED_“T_S,,
Target Madet | [™ Alternate Startup |
I Large j Cantraller Hardware
“sm =]
Figure 11
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The second option you can find in the project options of your
project. To get there, click on the Options -> Project menu in
your development environment. In the project options windows
you can see several notes. Click on the note C++ Options ->
Exception Handling/RTTlI. Now you can see some check
boxes on the right side of the window. The option Enable
exceptions has to be checked when using C++ exception

handling. Figure 12 illustrates the project option window and

the option which must be enabled.

Project Dptions =

Topics: Exception Handling/RTTI

= Directories -

oF Camnpiler E [¥ Enable excepti@ |

or 1 6-hit Compiler —

=C++ Options [~ Enable exception location information
= Member Pointer
@ C++ Compatibility

= Virtual Tables [~ Enable fast exception prologs
= Templates

[~ Enable destructar cleanup

[ Enable compatible exceptions (16-bit only)

* Exception Handling/RTTI

= General
=R O plimizations [~ Enable runtime type information

ortdezzages
oF Aszembler
o Linker

= Librarian
= Make

[ |

Set exception handling and run-time
type identification ophions

v [l 8 I’UndoF’agel x Cancell 2 Help |

Figure 12
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C++ class library

Both IPC@CHIP®

environments (Paradigm and Borland)

development

includes some C++ classes called class
library. The class library supports
typical functionalities for object-oriented
software development like streams,
strings, etc. A description of the hole
C++ class library is available in the
development environments help
system. Figure 13 shows an abstract of
the

Paradigm you can get there by clicking

class library description. In

on the Help -> Content menu and

opening the Paradigm C++ Class

BELCK.

Hilfethemen: Using Online Help

Inhalt Ilnde:-: I Suu:henl

Klicken Sie auf ein Buch und dann auf “Offren'”. Oder klicken Sie auf sin
anderes Register.

i E

@ Paradigm C++ Toolz and Utilities

@ Paradigrm C++ Programmer's Guide

@ The Runtime library reference

@ The Inline Azzembler

@ Paradigm Assembler Help

@ Paradigm C++ Class Libraries Programmer's Guide
m Paradigr C++ Clazz

W iostream classes

Librariez Reference Guide

@ Persizgtent streams claszes
@ Mathematical claszes
@ Run-Time Support claszes and functions
@ Clags Diagnostic Macros
@ C++ Service claszes
@ Paradigm C++ Error Meszages and Warmings

[

Schliefen I Drucken...

Abbrechen

Libraries Reference Guide book in the

Content tab. If you use the Borland IDE

Figure 13

open the classlib.hlp help file in the Help directory which you

can find in the Borland installation path on
(typical “C:\Program Files\Borland\BC5\Help”).

Note that not all classes described in the h

your hard disc

elp system are

supported by the IPC@CHIP® controller. The table below

shows which classes could be used for IPC@CHIP®

applications:

iostream classes: full supported

Persistent streams classes: not supported

Mathematical classes: full supported
Run-Time Support classes and

) full supported
functions:

Class Diagnostic Macros: not supported

the classes string, TSubString and

C++ Service classes:
TRegexp are suppo
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Summary

Below you can see a short summary of all important points

discussed in this document.

1)

2)

3)

4)

5)

6)

7)

8)

9)

Non static class methods cannot be referenced by
function pointers.

Assembler names of C++ symbols are named
differently than in C.

Non-static class methods expect an instance pointer
as an implicit parameter.

If a function is defined using a default parameter, the
default parameter has to be passed by the caller.

Using class instances or structure instances as return
value of functions or class methods could costs some
stack memory.

Declaring local variables inside the code costs stack
memory over the whole lifetime of the function.

If a function contains local static variables, the first
function call takes longer than the subsequent function
calls (because of the initialization).

Initializing a local variable by using the function itself or
another function which calls that function will result in
an endless loop.

When using global variables in initializers of other
global variables, be sure that all data used by the

initializer are already initialized.

10)For using C++ exception handling, the exception

handling must be enabled for the project.
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